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Brian Hill
Assignment for the next class:

(1) Read this document. It is an excerpt from https://astrodennis.com/Guide.pdf.(2) Download and install AstroImageJ v 5.0.0.00 from
https://www.astro.louisville.edu/software/astroimagej/
(3) Download the 5 sample files (Bias.zip, Darks.zip, Flats.zip, ScienceImages.zip, and Measurements_Tempate.zip) from https://astrodennis.com.

We will process the sample files in the next class. Then will take our own data and use it instead of Dennis’s sample data as one of our most significant projects in our remaining four weeks.
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6.1. Preparation Phase 
 

6.1.1. File Directories 
 

2Q�WKH�FRPSXWHU�WKDW�UXQV�WKH�REVHUYHU¶V�LPDJH�FDSWXUH�VRIWZDUH��it is best to initially setup the 
following subdirectories: AIJ Analysis, Bias, Darks, Flats, Quarantined Images, and Science 
Images. The AIJ Analysis subdirectory is where measurement and model fit files from AIJ can 
be stored.  The Bias, Darks, and Flats subdirectories are where the respective calibration files can 
be stored. The Science Images subdirectory would hold the raw images containing the target star, 
and the Quarantined Images subdirectory is where ³EDG´�VFLHQFH�LPDJHV�GXH�WR�FRVPLF�UD\�KLWV��
satellite, tracks, etc. could be parked.  If the user wishes to use other names for these 
subdirectories, then such names may be substituted for their respective counterparts in the 
examples that follow. 
 

6.1.2. Stabilization of Imaging System to Appropriate Temperature 
 
The imaging system should be put in place with enough time for it to reach its desired 
temperature set-point, which might also require enabling of its cooling system. 
 

6.1.3. Generation of Flat Files 
 
Whether twilight flats are taken or flats are generated by using an electroluminescence panel, 
they should (ideally) be redone prior to or after each imaging session using the same imaging 
chain as was used for taking the science images, and with the imaging chain not having been 
displaced or moved. See Section 6.3.2 for guidelines on creating flats. 
 

6.1.4. Autoguiding 
 
Autoguiding should be used during the Imaging Phase below, unless the oEVHUYHU¶V�PRXQW�LV�RI�
such accuracy that it can maintain guiding within a few pixels for the duration of the transit 
REVHUYDWLRQ��ZKHUH�WKH�DFWXDO�YDOXH�RI�³D�IHZ´�GHSHQGV�RQ�WKH�):+0�RI�WKH�KRVW�VWDU���See 
Section 4.4 above for an overview of various autoguiding techniques. The oEVHUYHU¶V�DXWR-
guiding mechanism should be calibrated, if not yet done or if the auto-guiding software does not 
automatically correct for changes in declination. If needed, calibration should also be done for 
any active optics (AO) system that is being used. 
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6.2. Imaging Phase 
 

6.2.1. Choice of Binning 
 
The FWHM of stars in the target field should be spread out over 3-5 pixels. If the imaging 
camera is normally setup to bin more than 1x1, binning might have to be reduced to achieve this. 
This then would result in DQ�DFFHSWDEOH�LPDJH�VFDOH��VRPHWLPHV�FDOOHG�³SODWH VFDOH´ RU�³SL[HO�
VFDOH´). Image scale is expressed in arc-seconds per pixel and is a function of the focal length of 
the telescope and the size of the CCD photosite. For example, assume that the FWHM is 3.0 arc-
seconds, and the unbinned image scale of the REVHUYHU¶V�LPDJLQJ�V\VWHP�LV�����DUF-seconds/pixel. 
This means that, without binning, the FWHM would be spread over 6 pixels and that 2x2 binning 
would mean that that the FWHM would be spread over 3 pixels, still within the acceptable, albeit 
the lower, part of the range. 

Stars should be brought into precise focus if for no other reason than to get an accurate measure 
of FWHM. However, if the target star is too bright and could saturate the imaging camera, it may 
be necessary to defocus the OTA. If the sky background is not too high, defocusing that results 
in a PSF of 10-���SL[HOV�LV�DFFHSWDEOH��DV�ORQJ�DV�WKLV�GHIRFXVLQJ�GRHVQ¶W�UHVXOW�LQ�WKH�IOX[�of a 
QHDUE\�VWDU�EOHQGLQJ�ZLWK�WKH�WDUJHW�VWDU¶V�IOX[� 
 

6.2.2. Choice of Exposure Time 
 
The optimal exposure time LV�RQH�WKDW�PD[LPL]HV�WKH�WDUJHW�VWDU¶V�615��ZKLOH�QRW�VDWXUDWLQJ�WKH�
LPDJLQJ�FDPHUD¶V�GHWHFWRU��)RU�D�Jiven target star, factors that affect the optimal exposure time 
include: 

1. WKH�WHOHVFRSH¶V�DSHUWXUH�VL]H� 
2. the filter used, 
3. the quantum efficiency (QE) of the imaging camera, 
4. whether the star is rising to the local meridian, or has passed the meridian and is falling, 

and 
5. seeing conditions. 

7RGD\¶V�CCD detectors typically have a linear range up to a point, after which they become non-
linear and then, at some point they become saturated. At its saturation point,  any additional 
photons hitting the CCD photosite will not be registered. Thus, it is critical that the target and 
comp stars never reach saturation and ideally not reach non-linearity as well (it should be noted, 
however, that software such as AIJ does provide a facility for making non-linearity corrections). 
It is important that the exposure time be chosen such that a decent SNR is achieved, but not long 
enough that neither non-linearity nor saturation occurs.  If the target star is predicted to rise 
toward the local meridian and, therefore its light will pass through less and less air mass, either 
of these two situations could occur. Thus, the observer should also take this into consideration 
when choosing an exposure time. Note that defocusing could also help this situation. 
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In order to initially set the correct exposure time, a series of test images should be taken with 
increasing exposure time. The SNR of the target star, as well as its ADU counts, could then be 
measured for each exposure setting. Section 7.5.1 describes how AIJ can be used to determine a 
stDU¶V�615���$Q�H[SRVXUH�VHWWLQJ�WKDW�PD[LPL]HV�615��EXW�GRHVQ¶W�SUHVHQW�D�SRWHQWLDO�IRU�
saturation during the imaging session should then be considered as the ideal exposure time. 

The following best practice procedure conducted immediately prior to the actual observing 
session is recommended to determine the optimal exposure time: 

1. $W�WKH�WDUJHW�VWDU¶V�FXUUHQW�VN\�SRVLWLRQ��WDNH�WHVW�LPDJHV�DW�YDULRXV�H[SRVXUH�WLPHV��)LUVW��
select the exposure time with the greatest SNR for the target star where the peak ADU 
FRXQW�LV�OHVV�WKDQ�����RI�WKH�VDWXUDWLRQ�SRLQW�RI�WKH�LPDJLQJ�FDPHUD¶V�GHWHFWRU�  Note: 
this 75% limit may have to be reduced if the camera is expected to reach non-linearity 
much earlier. 

2. If the star will be rising toward the local meridian, reduce the exposure time such that the 
detector will not reach saturation. 

3. If the star will be falling from the local meridian, increase the exposure time such that the 
peak ADU count of the target star is equal to 75% of the saturation point of the detector.  

There are some situations where the professional science team might require a certain cadence of 
images to be taken, which might be at the expense of the (longer) optimal exposure time. This 
may be the case where finer details of the pattern of the light curve are more important than the 
accuracy of the light curve depth itself. Also, to confirm some false positive scenarios, it may be 
necessary to increase the exposure time, and therefore the SNR, of faint stars near the original 
target, at the expense of possible saturation of the target. 
 

6.2.3. Time Synchronization 
 
%HFDXVH�RI�WKH�QDWXUDO�GULIW�LQ�WKH�LPDJH�FDSWXUH�FRPSXWHU¶V�FORFN��LW�VKRXOG�EH�IUHTXHQWO\�
synchronized with the U.S. NaYDO�2EVHUYDWRU\¶V�,QWHUQHW�WLPH�VHUYHr. This can be done using 
(freeware) software such as Dimension 4 (see http://www.thinkman.com/dimension4/).  The 
update period for such clock synchronizations should be set to at least every 2 hours. 
 

6.2.4. Time System 
 

Because of the existence of several different time systems, the exoplanet observer should be 
aware which one is being used for the transit prediction, which one is being entered into the 
image FITS headers, which one is being used during the light curve modeling process, etc. The 
more commonly used time systems are: 

a) Julian Date/Universal Coordinated Time (JDUTC), 
b) Heliocentric Julian Date/Universal Coordinated Time (HJDUTC), 
c) Barycentric Julian Date/Barycentric Dynamical Time (BJDTDB). 
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If the results of the exoplanet observation are to be used in a professional/amateur collaboration, 
BJDTDB would be the desired time standard to use during the model fitting process. Sections 
7.2.2 and 7.6 describe how AIJ can convert the time of the captured images to BJDTDB time. 
 

6.2.5. Operating Temperature 
 

The imaging system should be put in its operating environment with enough time for it to reach 
as low a temperature set-point as possible, which might also require enabling of its cooling 
system. 
 

6.2.6. Image Capturing 
 

7KH�REVHUYHU¶V�QRUPDO�LPDJH�FDSWXUH�VRIWZDUH�LV�XVHG�WR�FDSWXUH�WKH�VFLHQFH�LPDJHV�LQWR�WKH�
Science Images subdirectory during this phase. Should a meridian flip be necessary during the 
imaging session, then at the time the meridian flip is needed, the observer should: 

1. Abort the image capture software 
2. Stop autoguiding 
3. Execute the meridian flip 
4. Reposition the tDUJHW�VWDU�DV�QHFHVVDU\�LQ�WKH�FDPHUD¶V�ILHOG-of-view 
5. Enable autoguiding 
6. Enable the image capture software. 

 

6.3. Image Calibration Phase 
 

6.3.1. Calibration Files 
 

Prior to or after the capture of science images, the user would also capture a series of darks, flat 
field, and bias calibration files and store them in their respective subdirectories.  A rule of thumb 
is to (ideally) capture an odd number of images for each such calibration series. An odd number 
is suggested, since this better allows for a median combine to later be used to create the master 
dark, master flat, and/or master bias files. In any case, at least sixteen (16) images should be 
captured for each calibration file type. 

Guidelines for exposure times for each of these calibration file types are as follows: 

1. Dark files ± exposure time should equal that of the science images and should be taken at 
the same temperature as were the science images. 

2. Flat field files ± exposure time is dependent on the flat fielding technique used, but 
typically takes 3 seconds or less.  However, this exposure time may have to be increased 
for cameras with automatic shutters so that no shutter shading occurs. A rule of thumb is 
to create flat field frames such that the resulting histogram is mid-way within the 
dynamic range of the CCD detector.  For example, for a detector with a typical maximum 
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ADU count of 65,000, the brightness of the light source would be set such that the center 
of the resulting histogram is at 32,000 ADUs. As discussed in Section 6.3.2 below, 
special consideration is needed for the creation of flat files. 

3. Bias files ± a bias file is a dark file of 0 second exposure time. 

Typically, flat dark files are also created since the flat fields themselves contain dark current that 
needs to be subtracted out. When used, ³flat darks´ are taken at the same exposure time as the 
flat field files themselves. However, as seen in Section 7.2 below, a technique employed by AIJ 
that can scale the Master Dark to the same exposure time as the Master Flat obviates the need for 
the user to generate flat dark files. 
 

6.3.2. Flat Fielding Techniques 
 

Because star movement over a few pixels is inevitable even with autoguiding and fairly accurate 
polar alignment, flat field correction is relied upon to mitigate the effects of dust donuts and 
vignetting. Poor flat fielding is one of the major contributors to systematics. For example, Figure 
1 depicts a flat field and the potential movement of a star onto a nearby dust donut. Figure 2 
depicts what would happen in the case of a meridian flip, namely the star would flip across the 
diagonal of the detector and possible land on another dust donut. If flat field correction is not 
performed for either of these two cases, the flux of the star in question would artificially change. 

 

 

 

Figure 1.  Star Movement in an Uncorrected Flat Field 
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Figure 2.  Star Movement after a Meridian Flip 

Flat fields should ideally be created before or after each observing session, and certainly when 
there is any change in the imaging chain. 

The following are common techniques for generating flat fields from which a master flat can 
then be created: 

1. Twilight flats ± flats are taken at dawn and dusk. Because of the speed that sky lighting 
conditions change, it is often cumbersome to take a good set of flats, especially if this has 
to be done for multiple filters. In some cases, the flats may show stars if the exposure 
time is too long. Homemade diffusers using a white T-shirt have been a popular way to 
mitigate this problem. 

2. Light boxes ± homemade light boxes have been used by some amateur astronomers to 
create flats. However, using this technique to produce a uniform light field is sometimes 
challenging. 

3. Electroluminescence panels -  although at some cost, the technique has several 
advantages: it can create a relatively good uniform light field, its brightness can be 
FKDQJHG�WR�DFFRPPRGDWH�GLIIHUHQW�ILOWHUV��DQG�IODWV�PD\�EH�WDNHQ�DW�WKH�REVHUYHU¶V�
convenience. 

4. Observatory flats ± this technique used in permanent observatories consists of the 
telescope being pointed to a lit white panel on the wall of the observatory. The efficacy of 
this technique varies widely with the nature of the white panel, ambient lighting, etc. 



 

19 
 

 
6.3.3. Creation of Master Files 

 
Image calibration eliminates the effects of the following underlying factors that affect the 
precision of the measurements: bias, dark current, and dust donuts and vignetting. The following 
are best practices for dealing with each of these factors: 

1. Bias files should be taken at some time before or after the observing session. These are 
then used to create a master bias file, ideally using median combine.  

2. Dark files should best be taken at the end of the observing session. The reason for taking 
them at the end of the observing session is to make sure that they are taken at the same 
temperature as the science images. A master dark file is then created from them, again 
using median combine. 

3. Flat files should be taken either at the beginning or end of the observing session. Since 
flat files themselves have dark current and are at a different exposure time than the 
science images, they need to have dark current removed. Rather than creating a master 
dark specifically to make dark correction for the flats, another approach is to use the same 
master dark file created for the science images, but scale it to the exposure time of the flat 
files. Software such as AIJ, has such a scaling feature. Section 6.3.2 above describes the 
best practices for creating flat files. 
 

6.3.4. Updating FITS Header Information 
 

During the image calibration phase, some software packages such as AIJ allow the user to update 
the FITS headers in the science images with information such as the equivalent BJDTDB times of 
the observation. If not included in the FITS header by the image capture software, other 
important information such as AIRMASS can be included as well. As will be seen later, 
AIRMASS is one of the more commonly used detrend parameters during the transit modeling 
process. 
 

6.4. Aperture and Differential Photometry Phase 
 

As was mentioned in Section 3, the exoplanet transit method is all about comparing the relative 
change in brightness between the target star and a set of suitable comparison stars. Before this 
comparison can be done, however, the brightness of each star needs to be adjusted for any 
photon counts due to the background sky that might be affecting each particular star. This is 
done using aperture photometry. Once this is done, the relative change in (adjusted) flux between 
the host star and the comparison stars can then be obtained. This process is called differential 
photometry. The best practices associated with aperture and differential photometry are 
described below. 
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6.4.1. Aperture Photometry 
 

Aperture photometry involves GHILQLQJ�ERWK�WKH�³DSHUWXUH´�RI�D�FHUWDLQ�UDGLXV�DURXQG�D�VWDU��DV�
ZHOO�DV�DQ�RXWHU�³DQQXOXV�´�7KH�LGHD�RI�WKH�DQQXOXV�LV�WR�PHDVXUH�WKH�VN\�EDFNground around the 
star. Figure 3 depicts an aperture of radius 9 and an annulus starting at 16 pixels from the 
centroid of the star and ending at pixel location 24. 

 

 

Figure 3.  Aperture and Annulus 

In order to compensate for background sky contribution, the ADU counts per pixel in the annulus 
are used to adjust the ADUs in the aperture. Some software such as AIJ also has the ability to 
detect and adjust for any faint stars that might happen to be in the annulus and therefore bias the 
background sky counts. As will be described later, the radii settings initially set for the aperture 
and annulus may be changed after an exoplanet model fit is done to further optimize the fit. 

Section 7.5.1 describes how AIJ can be used to select the initial size of the aperture and annulus. 
 

6.4.2. Differential Photometry  
 
Differential photometry involves applying aperture photometry on the target star and multiple 
comparison stars and then comparing the relative differences in (adjusted) flux. The following are 
the best practices for selecting suitable comparison stars: 

1. Ideally, at least 8 comparison stars should be chosen whose magnitudes are as close as 
possible to that of the target star ± i.e., no greater than 0.75 in magnitude (i.e., fainter) and 
no less than 0.44 in magnitude (i.e., brighter) than the target star. If this is not possible, 
then an ensemble of comparison stars should be selected such that the average of their 
aperture counts is close to that of the target star.  Also, when trying to determine if there 
are any sources causing a false positive, the observer may be instructed to test for the 
occurrence of a transit event for all stars within a specified radius of the target star. 

2. The comparison stars should ideally be of similar stellar type to the target star in order to 
minimize the differences in atmospheric extinction. However, if the transit modeling 
software is able WR�³GHWUHQG´�WKH�HIIHFWV�RI�$,50$66��VXFK�DV�LV�SRVVLEOH�ZLWK�$,-��WKHQ�
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choosing comparison stars of similar brightness to the target star is more important than 
choosing stars of similar stellar type. 

3. The comparison stars should not be inherently variable. This can later be determined by 
viewing the light curve of each comparison star as described in the next section, or by using 
LQIRUPDWLRQ� IURP� WKH� $$962¶V� 9DULDEOH� 6WDU� 3ORWWHU� XWLOLW\� �$$962�� ������ 
 

The results of the differential photometry phase will be a Measurements file that has, as a 
minimum, for each image: the timestamp of the image, the change in flux or magnitude of the 
target star (relative to the comparison stars), and its associated errors.  Depending upon the 
differential photometry software, other valuable data could include the relative change in flux or 
magnitude of each comparison star (relative to all the other comparison stars), their associated 
errors, and changes in the X,Y pixel coordinates of the target and comparison stars. 

 

7. Using AstroImageJ 
 

The rest of this Guide describes the use of AIJ for the post-processing of science images and for 
conducting exoplanet model fitting. The use of AIJ assumes that the user has already installed 
AIJ and has read the AIJ User Guide, available at: 
http://www.astro.louisville.edu/software/astroimagej/. 

The user is encouraged to regularly check for an AIJ software update.  This is done by clicking 
on Help in the upper right corner of the main AIJ Toolbar (see Figure 4) and then selecting 
³8SGDWH�$VWUR,PDJH-«´. An ³Upgrade To´ box then appears. IMPORTANT: If a daily build 
exists, please load it. This can be found by going UP in the Upgrade To box.  

 

Figure 4.  AIJ Toolbar 

Data from actual exoplanet transits will be used in the examples throughout the rest of this 
Guide. Both the calibration files and original images for the WASP-12b example can be found at 
http://astrodennis.com. 
 

7.1. Loading Images into AIJ 
 
A single image or a sequence of images can be loaded into AIJ. 

To open a single image, select File->Open from the AIJ Toolbar (Figure 4) and then select the 
desired file. The Image Display screen (see Figure 5) then appears. One example of useful 



 

22 
 

information that can be obtained from any one of the science images are the contents of its FITS 
header.  This information can be obtained by selecting Edit->FITS header on the top of the 
Image Display screen.  Many of the operations on the Image Display Screen that are described 
below for a sequence of images can also be applied to a single image. 

 

Figure 5.  Image Display Screen 

A set of images can be ORDGHG�LQWR�ZKDW�LV�FDOOHG�DQ�$,-�³VWDFN�´�(DFK�LPDJH�LQ�WKH�VWDFN�LV�
FDOOHG�D�³VOLFH�´��7KH�VWDFN�LV�DQ�DFWLYH�VHW�RI�LPDJHV�WKDW�YDULRXV�$,-�IXQFWLRQV�FDQ�EH�DSSOLHG�WR��
From the AIJ Toolbar select File->Import->Image Sequence. For Windows users,  then select 
ONE file in the subdirectory containing the calibrated science images (note: do not try to select a 
range of images; it is necessary only to select one of the files in the subdirectory).  For MAC 
users, select the subfolder containing the desired images to be displayed. A screen similar to the 
one in Figure 6 appears. 
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Figure 6.  Sequence Options Screen 

If the computer running AIJ has sXIILFLHQW�PHPRU\�WR�KROG�DOO�LPDJHV�LQ�WKH�VWDFN��WKHQ�WKH�³8VH�
YLUWXDO�VWDFN´�VHOHFWLRQ�RQ�WKH�6HTXHQFH�2SWLRQV�VFUHHQ�FDQ�EH�XQFKHFNHG��WKHUHE\�FDXVLQJ�$,-�
to run faster since the images can be directly accessed from memory.  If an out-of-memory 
message appears in this case, then more memory can be allocated to AIJ by performing the 
following: 

1. From the main AIJ Toolbar, go to Edit->Options->Memory and Threads« 
2. Change the Maximum memory value to a larger value. 

Next, with the boxes checked as in Figure 6, with the possible exception of the virtual stack 
selection, select OK. This creates an AIJ stack of the calibrated science images. The Image 
Display (Figure 5) then shows the first image in the stack. 

 
 
7.2. Calibrate Science Images 
 
The Data Processing (DP) function of AIJ can first be used to calibrate the science images taken 
during the Imaging Phase. Note: Before proceeding with this section, it is strongly suggested that 
the reader review Section 6 (DP User Interface) of the AIJ User Guide. The DP function is 
initiated by clicking on the   LFRQ�IURP�$,-¶s main Toolbar. Figure 7 is an example of one of 
the two screens that then appears. 
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Figure 7.  CCD Data Processor Screen 

An example of the other screen that appears is depicted in Figure 8, which may initially be 
covering the CCD Data Processor Screen. 

 

 

Figure 8.  DP Coordinate Converter Screen 
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The purpose of the CCD Data Processor screen is to calibrate the science images using the bias, 
dark, and flat field files previously captured. There are several ways, however, in which the 
master bias, dark, and flat files used for calibration can be created. For example, the master files 
can be created in separate runs of the CCD Data Processor, and then one final run specifies the 
master files being used. In addition, the user may use other programs for accomplishing the 
calibration and may simply decide to use AIJ to just update the FITS headers of the calibrated 
files, which process is described below. In the example depicted in Figure 7 and described 
below, AIJ uses one run to accomplish everything: master files are first created from individual 
bias, dark and flat files, these master files are then used to calibrate the 336 science images, and, 
finally, the FITS headers of the resulting calibrated files are updated. In the example below, the 
original dark files and science images had an exposure time of 45 seconds and the flat field files 
had an exposure time of 3 seconds. 
 

7.2.1. Specifying Science Images and Calibration Files 
 

The first step in conducting image calibration is to specify where AIJ can find the science images 
and the calibration files. 

8QGHU�WKH�6FLHQFH�,PDJH�3URFHVVLQJ�VHFWLRQ�RQ�WKH�&&'�'DWD�3URFHVVRU�VFUHHQ��WKH�³(QDEOH´�
DQG�³6RUW�1XP´�ER[HV�DUH�FKHFNHG�DQG�WKH�GLUHFWRU\�is entered where the science images reside 
(this can also be done by clicking on the folder icon and selecting the appropriate subdirectory).  
1H[W��WKH�DSSURSULDWH�ILOH�H[WHQVLRQ�ZLWK�WKH�ZLOGFDUG�LQGLFDWRU�³
´�IRU�WKH�ILOHQDPH�SDWK�LV�
entered. If the filename path and extension for the science images have been properly entered, 
then the Totals count to the right should be correct. 

The above method should also be used for specifying the subdirectories and file extensions for 
the bias, dark and flat files.  For each of these sets of calibration files, a subdirectory and full 
filename (not just extension) should be entered for their respective to-be-created master files. For 
example, in Figure 7, a master dark called mdark.fits will be created in the same subdirectory 
where the individual darks are found. 

The Build and Enable checkboxes for each of the calibration types should also be checked, and 
the choice made for whether average (ave) or median (med) combine should be used to create the 
masters. If the darks are to be scaled and uVHG�DV�IODW�GDUNV��WKHQ�WKH�³VFDOH´�DQG�³GH%LDV´�ER[HV�
should be checked. 
 
There are variations to the above.  FRU�H[DPSOH��WR�XVH�DOUHDG\�FUHDWHG�PDVWHUV��WKH�³%XLOG´�
boxes do not have to be checked. 

1RWH��,W�LV�LPSRUWDQW�WKDW�WKH�³5HPRYH�2XWOLHUV´�RSWLRQ is NOT selected when differential 
photometry is being done and that the Polling Interval under the Control Panel is set to 0. Also, 
unless the ³(QDEOH´�RSWLRQ�IRU�)LOHQDPH�1XPEHU�)LOWHULQJ�RU�WKH� ³(QDEOH�/LQHDULW\�&RUUHFWLRQ´�
option are being used (see Section 6.3.2.1 and Section 6.3.2.5, respectively of the AIJ User 
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Guide), then they should not be enabled. 
 

7.2.2. Updating FITS Header Information 
 

AIJ has two methods for obtaining some essential information such as AIRMASS, BJDTDB 
times, etc., which will be useful during the Photometry, Plotting, and Modeling Phase. The first 
method is to update the Measurements file that is created after differential photometry has been 
applied to the calibrated images. This method is described in Section 7.6 below. This method, 
however, does not update the FITS headers of the calibrated files, so each time a new differential 
photometry measurement is performed on the calibrated images, this update would have to take 
place again. It should be noted that some camera capture software will include AIRMASS in the 
FITS header, but most likely not BJDTDB. 

The second method, which occurs during the Calibration Phase, is to include this information 
directly in the FITS headers of the calibrated files. Thus, at the time the calibration files are 
being corrected with any bias, darks, and flats, their FITS headers are being updated as well. 
With this method, multiple modeling runs can be made with different photometry settings, 
without having to update the Measurements file after each run with information such as 
AIRMASS and BJDTDB time. 

To update the FITS headers during the calibration process, the user should select General under 
the FITS Header Updates section of the CCD Data Processor screen (see Figure 7). The DP 
Coordinate Converter Screen then appears (Figure 8���LI�LW�LVQ¶t already open.  

To update the FITS headers,  AIJ needs the RA and DEC coordinates of the target, as well as the 
location where the observation was conducted. This information can be manually entered, or AIJ 
can automatically extract this data from the FITS headers if it was included there by the user¶s 
image capture software. 
 

7.2.2.1. Entry of Target and Observation Location Information 
 

In the case of manual entry RI�WKH�WDUJHW¶V�FRRUGLQDWHV and/or the observation location, the user 
would select ³&RRUGLQDWH�&RQYHUWHU�PDQXDO�HQWU\´ under either or both the Target Coordinate 
Source box and the Observatory Location Source box. On the DP Coordinate Converter screen, 
the user would then enter the Lon (Longitude), Lat (Latitude), and Alt (Altitude) fields in the 
Geographic Location of Observatory section and/or enter WKH�WDUJHW¶V�5$�DQG�'(&�ILHOGV�Ln the 
J2000 Equatorial section. $�GHVFULSWLRQ�RI�KRZ�WKH�XVHU�FDQ�FUHDWH�DQ�HQWU\�IRU�WKH�XVHU¶V�
observatory, in a list of pre-defined observatories, FDQ�EH�IRXQG�XQGHU�³&XVWRPL]H�2EVHUYDWRU\�
'DWD�´�ZKLFK�FDQ�EH�UHDFKHG�IURP�WKH�+HOS�WDE�RQ�WKH�'3�&RRUGLQDte Converter screen. The user 
can then later access this stored information via  the Observatory ID pull-down list on the DP 
Coordinate Converter screen in order to automatically populate the entries for the Geographic 
Location of Observatory. 
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If RA and DE&�FRRUGLQDWHV�DUH�DOUHDG\�SDUW�RI�WKH�LPDJH¶V�),76�KHDGHU��WKH�XVHU�ZRXOG�VHOHFW�
³),76�KHDGHU�WDUJHW�5$�'(&�������´�XQGHU�WKH�7DUJHW�&RRUGLQDWH�6RXUFH�ER[��,I�WKH�
REVHUYDWLRQ�ORFDWLRQ�LV�DOUHDG\�SDUW�RI�WKH�LPDJH¶V�),76�KHDGHU��WKH�XVHU�ZRXOG�VHOHFW�³),76�
KHDGHU�ORQJLWXGH�DQG�ODWLWXGH´�XQGHU�WKH�2EVHUYDWRU\�/RFDWLRQ�6RXUFH�ER[�� 
 

7.2.2.2. Dynamical Time Updates 
 
No matter which method is used by $,-�WR�REWDLQ�WKH�WDUJHW¶V�FRRUGLQDWHV�DQG�WKH�REVHUYDWLRQ�
location, the user should select Auto under  the Dynamical Time section of the DP Coordinate 
Converter Screen. This will allow AIJ to account for the appropriate number of additional leap 
seconds when it is doing its time conversions to BJDTDB . 
 

7.2.2.3. Other Required FITS Header Information 
 

Next, it is important that the raw science images have information in their FITS headers about 
the date/time of the start of the observation, as well as the exposure time. Sections 6.3.2.6.1 and 
6.3.2.6.2 of the AIJ User Guide describe the acceptable FITS header keywords that AIJ can use 
to obtain this information. 
 

7.2.2.4. FITS Header Settings 
 

Once the above observatory and target information is filled in, and it is confirmed that the FITS 
headers contain acceptable date/time and exposure information, then the user would select the   

 icon on the CCD Data Processor screen.  The General FITS Header Settings screen then 
appears (Figure 9). 
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Figure 9.  General FITS Header Settings Screen 

If the automatic entry method was used for the target coordinates, then the appropriate keywords 
LQ�WKH�LPDJH¶V�),76�KHDGHU�DVVRFLDWHG�ZLWK�WKLV�LQIRUPDWLRQ�VKRXOG�EH�LQFOXGHG�LQ�WKH�7DUJHW�5A 
Keyword and Target DEC Keyword entries under the FITS Header Input Settings portion of the 
screen (see Figure 9). Common keyword pairs for this information are: RA_OBJ, DEC_OBJ and 
OBJCTRA, OBJCTDEC; however, the user should confirm which keyword pair is placed in the 
LPDJHV¶�),76�KHDGHU�E\�WKH�XVHU¶V�LPDJH�FDSWXUH�VRIWZDUH� 

Likewise, if the automatic entry method was used for the observation location, then the 
appropULDWH�NH\ZRUGV�LQ�WKH�LPDJH¶V�),76�KHDGHU�DVVRFLDWHG�ZLWK�WKLV�LQIRUPDWLRQ�VKRXOG�EH�
included in the Observation Latitude Keyword and Observation Longitude Keyword entries. 
SITELAT and SITELONG are such keywords. NOTE: some image capture software, such as 
SkyX Pro, might put a positive number in the FITS header for longitude even though it is West 
longitude (West longitude is typically shown with a negative sign, unless it is expressed as 
Elongitude ± namely, total degrees from 0 longitude.). If West longitude is a positive number in 
WKH�XVHU¶V�),76�KHDGHU��WKHQ WKH�XVHU�VKRXOG�FKHFN�WKH�³QHJDWH´�ER[�WR�LQGLFDWH�WR�$,-�WKDW�WKH�
number found in the FITS header should really have a negative sign associated with it. 

The FITS Header Output Settings portion of the screen indicates which items will be added to 
the calibrated images (indicated by those that have ³HQDEOHG´ checked).  Note: it is suggested that 
all the default NH\ZRUGV�VWD\�DV�³HQDEOHG�´ 
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IMPORTANT: If an AIJ update is performed, the user is advised to make sure that the entry for 
WKH�³%-'��7'%��PLG-2EV�.H\ZRUG´�RQ�WKH�*HQHUDO�),76�+HDGHU�6HWWLQJV�VFUHHQ�LV�VHW�WR�
BJD_TDB (earlier versions of AIJ set this entry value to BJD_UTC). 
 

7.2.2.5. WCS Information 
 

Finally, although not done in this example, the World Coordinate System (WCS) coordinates for 
each star in each image can be obtained by selecting the Plate Solve option on the CCD Data 
Processor Screen.  It should be noted, however, that this process could take a long time and in 
many cases is not necessary (see Section 7.4 below for obtaining WCS coordinates for selected 
images). 
 

7.2.3. Begin the Calibration Process 
 

Using the above as an example, when the START button is selected, the DP routine will 
automatically perform the following steps: 

1. Create a Master Bias (mbias.fits) from the 16 bias files. 
 

2. Create a Master Dark (mdark.fits) from the 16 dark files. Correct this Master Dark with 
the Master Bias. Thus, the Master Dark will have bias removed from it. 
 
 

3. Create a Master Flat (mflat.fits) using the 16 flat files in the following manner: 
 

a. first calculate a scaling factor that represents the ratio of the exposure times of the 
flat fields to the exposure time of the original dark files (in this example, the 
scaling factor would be 0.0667=3 sec/45 sec); 

b. perform bias correction using the Master Bias; 
c. perform dark correction using the Master Dark, scaled with the scaling factor; 
d. remove gradients; 
e. normalize the calibrated flats. 

 
4. The FITS headers of the calibrated files are updated. 

 
5. Calibrate each science image using the resulting Master Bias, Master Dark, and Master 

Flat. An Image Display is seen for each image as it is being calibrated. 
 
 

6. The calibrated science images are stored in a calibration subdirectory under the 
subdirectory that held the Science Images. In this example, the subdirectory will be called 
pipelineout and its files will have a suffix of _out. Note: it is best to check the 32 bit 
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option for these saved calibrated files. 
 

7.2.4. Real-time Operation 
 

In addition to conducting image calibration after the observation, AIJ is also capable of operating 
³LQ�UHDO-WLPH´�LI�WKH�3ROOLQJ�,QWHUYDO�LV�VHW�WR�D�QRQ-zero value and the appropriate options are 
selected in the Post Processing section.  In this case, at the specified Polling Interval rate, AIJ 
will automatically check the science image directory for newly added files that match the file 
pattern matching and number filtering criteria specified on the CCD Data Processor screen. AIJ 
will then calibrate them, will optionally conduct differential photometry on them, and will 
optionally update the light curve (see the checkboxes under Post Processing on the CCD Data 
Processor screen for selecting these options). 
 

7.2.5. Additional Options 
 
Section 6 of the AIJ User Guide provides other options available for the CCD Data Processor 
screen. 
 

7.3. Loading Calibration Images 
 
After calibration, the images in the calibration subdirectory can be loaded into AIJ (see Section 
7.1 on how to load a set of images). 

In order to make sure that the field-of-view (FOV) indicators are correct for both the vertical and 
horizontal axes on the Image Display Screen for the calibration images, the correct X and Y 
pixel scales should be set. Pixel scales will have been set correctly if WCS coordinates were 
already found by using either the Plate Solve option on the CCD DP Processor screen (see 
Section 7.2.2.5) or one of the WCS->Plate solve options on the Image Display screen (see 
Section 7.4). Alternatively, correct pixel scales can be manually entered by selecting, at the top 
of the Image Display Screen, ³WCS->Set pixel scale for images without :&6«´, and then 
entering the correct X and Y pixel scale values. 

The slider below the image can then be used to move through all the images in order to find ones 
that should be eliminated due to excessive cloud cover, poor guiding, or other anomalies. If 
images show increasing degrees of misalignment, see Section 7.5.3 how to correct for this. Poor 
images can be deleted by bringing up that particular image on the Image Display and then simply 
VHOHFWLQJ�WKH�³GHOHWH�FXUUHQWO\�GLVSOD\HG�VOLFH´  icon in the upper left of the Image Display. 
Alternatively, Edit->Stack->Delete can be selected from the menu bar on the Image Display.  It 
is advisable, however, to move such poor images from the calibration subdirectory where they 
UHVLGH�WR�D�VHSDUDWH�³4XDUDQWLQHd Images´�subdirectory.  This is so that if the differential 
photometry needs to be redone on files in the calibration subdirectory, then the user does not 
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have to go through this image elimination process again. 
 

7.4. Plate Solving Using AIJ 
 
Plate solving means associating stars in an image with their RA and DEC coordinates. 
Optionally, this information can also be permanently stored EDFN�LQWR�WKH�LPDJH¶V�),76�KHDder 
for possible later use. The information stored in the FITS header uses WCS information; this 
information allows subsequent runs to identify the RA and DEC coordinates of selected stars. 

The following are examples where it might be desirable to use one or more plate solved images: 

1. it may be useful to plate solve an image to locate the exact location of the target star in a 
crowded field of stars; 

2. if images are misaligned throughout the observing session, or a meridian flip has 
occurred, it may be useful to track the location of particular stars from one image to the 
next during the differential photometry process using their RA and DEC coordinates. 

Images that contain WCS information from other software can be used by AIJ, or AIJ itself can 
be used to plate solve one or more images in the image stack. This is done by selecting from the 
Image Display PHQX�³:&6-!3ODWH�VROYH�XVLQJ�$VWURPHWU\�QHW��ZLWK�RSWLRQV�«´�$�VFUHHQ�
similar to the one in Figure 10 then appears. 

 

Figure 10.  Astrometry Settings Screen 

AIJ can then use either the online astrometry.net facility for plate solving, or Windows users can 
use a local version that does not require an online connection. The following describes each of 
these alternatives. 
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7.4.1. Astrometry.net Alternatives 
 
Alternative 1: Plate Solving Using the Online Version of Astrometry.net 

For this alternative, an Astrometry.net key is first obtained. This is done by logging in at 
http://nova.astrometry.net/signin/?next=/api_help XVLQJ��IRU�H[DPSOH��WKH�XVHU¶V�<DKRR�ORJLQ�
LQIRUPDWLRQ��7KH�NH\�FDQ�WKHQ�EH�IRXQG�XQGHU�0\�3URILOH��,W�LV�FDOOHG�³P\�$3,�NH\�´�This key is 
then entereG�LQWR�WKH�8VHU�.H\�ILHOG�RQ�$,-¶V Astrometry Settings Screen. 

Alternative 2: Plate Solving Using a Local Version of Astrometry.net 

Windows users can use can an alternative to the online version of astrometry.net to perform plate 
solving. In this case, AIJ uses a local  astrometry.net server. The server, developed by Andy 
Galasso, is called ansvr.  It can be installed by going to http://adgsoftware.com/ansvr/ and 
following the installation instructions there. Once installed, plate solving can be done locally by 
HQDEOLQJ�³8VH�&XVWRP�6HUYHU´�RQ�WKH�$VWURPHWU\�6HWWLQJV�6FUHHQ��VHH Figure 10). 

7.4.2. Astrometry Information 
 

After the appropriate alternative for invoking astrometry.net is chosen, the following other 
entries should be made on the Astrometry Settings Screen: 

1. ³$XWR6DYH´�VKRXOG�EH�FKHFNHG�LI�WKH�XVHU�ZLVKHV�that the FITS headers of the original 
image files are to permanently updated with the appropriate WCS information. 

2. 6HOHFWLRQ�RI�WKH�³$QQRWDWH´�RSWLRQ�DOORZV�$,-�WR�GUDZ�around stars found in SIMBAD, a 
FLUFOH�RI�VL]H�³5DGLXV��SL[HOV�,´ along with an annotation of the star name. If selected, 
³$GG�7R�+HDGHU´�ZLOO�FDXVH�WKHVH�DQQRWDWLRQV�WR�EH�DGGHG�WR�WKH�LPDJH¶V�),76�KHDGHU� 

3. The slice number(s) of the image(s) in the stack to be plate solved should be entered in 
the Start Slice and End Slice fields. 

4. The radii of the aperture and annulus settings that will be used during the differential 
photometry process (see Section 7.5.1 below) should be entered in the Radius, Sky Inner, 
and Sky Outer fields. 

5. 7KH�FRUUHFW�3L[HO�6FDOH�YDOXH�IRU�WKH�XVHU¶V�LPDJLQJ�V\VWHP�VKRXOG�EH�WKHQ�EH�HQWHUHG��DV�
well as some tolerance for its precision. 

6. Next, the approximate RA and DEC coordinates of the center of the image, as well as 
some search radius for suitable stars that can be used during the plate solve process. The 
user might try first starting with the width of the image, and then reduce it from there. 

7. All other values and checkboxes can be set as they appear in Figure 10.  When START is 
selected, the plate solving process will begin 
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7.5. Conduct Differential Photometry 
 

With known candidate comp stars, differential photometry can take place on the images in the 
stack. See Section 6.4.2 for guidelines on selecting suitable comp stars. 
 

7.5.1. Select Appropriate Aperture and Annulus Settings 
 
The first step is to define the appropriate radius of the aperture and the radii of the inner and 
outer rings of the annulus. This is done as follows: 

The   icon on the Image Display screen is selected causing the Aperture Photometry Settings 
screen to be displayed (Figure 11) . 

 

Figure 11.  Aperture Photometry Settings Screen 

The initial radii of the aperture and annulus can then be appropriately set using any one of three 
methods. 

Method 1.  The initial radii settings can be determined using the Seeing Profile screen associated 
with the target star (see Figure 12). This screen appears when the cross-hairs is placed on the 
target star and the user holds the ALT key down while clicking on the star (note: that ALT-
clicking the star does not keep the cross-hairs on the star). The radius shown for the Source and 
the beginning and ending values for the Background can then be used for the initial aperture 
radius, and the inner and outer annulus radii settings, respectively. 
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Figure 12.  Seeing Profile Screen 

Method 2. The initial radii can also be determined according to the following guidelines (note 
that $,-¶V�DXWRPDWLF�VHOHFWLRQ�RI�UHFRPPHQGHG�YDOXHV�YLD�0HWKRG���LV�consistent with these 
guidelines): 

1. The initial radius of the aperture (r1) should be at least 2 times the number of FWHM 
pixels. 

2. The initial radius of the inner annulus (r2) should be chosen such that it and the radius of 
the outer annulus create an annulus region that excludes any other stars that happen to be 
close to the target star. 

3. The initial value of the outer annulus radius should equal the SQRT(4*r1
2+r2

2).  This 
formula should produce an annulus that contains 4 times the number of pixels that are in 
the aperture. 
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Method 3.  Finally, the initial aperture/annulus settings can be determined by using the ones that 
maximize the SNR of the target star. AIJ can be used to determine the SNR of the target star in 
the following manner: 

1. Click on the Set aperture settings icon   on the Image Display screen. Set the aperture 
and annulus radii to some initial settings and then click on OK.  

2. Click on the Single Aperture Photometry icon  on AIJ¶V�Toolbar. Place the resulting 
concentric circles onto the target star in the Image Display and left click. 
 

3. This will produce a new Measurements table that should include the SNR measurement 
under the column Source_SNR. Each subsequent change in aperture settings and Single 
Aperture Photometry selections will add a new row to this table. 

Note: each such newly created (extraneous) row in the Measurements table should then be 
deleted before the Measurements table is used for transit modeling. This is done by highlighting 
the row(s) to be deleted in the Measurements table and then selecting Edit->Cut from the 
Measurements table menu bar. 

Of the above three methods, Method 1 is the preferred one for obtaining an initial set of aperture 
and annulus settings. 

It should be noted that the final settings of the aperture and annulus radii should be those that 
minimize the Root Mean Square (RMS) of the residuals of the light curve that is created during 
the transit model fit��506�LV�D�PHDVXUH�RI�KRZ�ZHOO�WKH�PRGHO�³ILWV´�WR�WKH�REVHUYHG�GDWD��7KLV�
implies that multiple runs of the model fit, as described in Section 7.11 below, would need to be 
run with different values for the aperture and annulus radii settings. 
 

7.5.2. Prepare For and Begin the Differential Photometry 
 
In scanning through the images in the stack, it may appear that they are gradually offset from 
each other and therefore not all aligned. Sections 7.5.3 and 7.5.4 below show how to deal with 
varying degrees of misalignment, as well as a meridian flip. 

On the Aperture Photometry Settings Screen (Figure 11), the user should enter a comma-
separated list of keywords for any FITS header values that the user would like extracted and 
added to the Measurements table. In addition, WKH�DSSURSULDWH�YDOXHV�IRU�WKH�&&'¶V�JDLQ��UHDGRXW�
noise and dark current should be entered.  Finally, the appropriate settings for Saturation and 
Linearity warnings should be set. All of the other checkboxes could be kept as shown in Figure 
11. The user would then select OK. 

Next, the    LFRQ�RQ�WKH�,PDJH�'LVSOD\¶V�PHQX�EDU�ZRXOG�EH�VHOHFWHG�WR�EULQJ�XS�WKH�0XOWL-
Aperture Measurements screen (see Figure 13). Values for the range of slices and aperture and 
annulus radii are automatically filled in. If all WKH�LPDJHV�ZHUH�SODWH�VROYHG��WKHQ�³8VH�5$�'HF�WR�
ORFDWH�DSHUWXUH�SRVLWLRQV´�FRXOG�EH�FKHFNed. All other checkboxes could be kept as in Figure 13. 
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Figure 13.  Multi-Aperture Measurements Screen 

The user should also have enabled the following four icons on the Image Display menu bar: 

 

These selections allow for the aperture/annulus rings to be displayed with target and comp star 
names and associated intensity counts, and helps to automatically position the aperture/annulus 
rings RQ�HDFK�VWDU¶V�FHQWURLG� Note that in a crowded field, it may be appropriate to disable 
displaying of the annulus rings and intensity counts by deselecting the first and third of the above 
four icons. 

The user would then select Place Apertures and then place and click the floating concentric 
circles on the target star and the comp stars. The Image Display would then appear similar to that 
in Figure 14. 
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Figure 14.  Sample Image with Aperture/Annulus Applied to 
Target and Comp Stars 

Next, by hitting Enter on the keyboard, the differential photometry process will begin. A 
Measurements table will be constructed with each row representing the measurements for each 
slice in the stack. The labels in the Measurements table header identify the type of data in the 
ODEHO¶V�FROXPQ��6RPH�RI�Whese labels correspond to common FITS header identifiers, and others 
are the Keywords specified in the Aperture Photometry Settings display (see Figure 11). 

The following are some of the more important values in the Measurements table that will later be 
used in the exoplanet analysis (in the notation below, xx =Tn for a star designated as a target and 
xx=Cn for a star designated as a comparison star): 

Source-Sky_xx ± ADU counts within the photometry aperture, adjusted for the sky 
background counts that are in the photometry annulus; 
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tot_C_cnts ± total Source-Sky counts of all the selected comparison stars; 
rel_flux_Tx ± relative flux of target star Tn =  Source-Sky of Tn divided by tot_C_cnts; 
rel_flux_Cx ± relative flux of comparison star Cn =  Source-Sky of Cn divided by the 
     total Source-Sky counts of all the other selected comparison stars; 
rel_flux_err_xx ± error associated with the corresponding relative flux. 

At this point, the Measurements table should be saved to a subdirectory like something called 
AIJ Analysis. This is accomplished by selecting File->Save As on the Measurements table menu 
and selecting the AIJ Analysis subdirectory. The Measurements table can then be stored by AIJ 
with an extension of .xls, .tbl, or .txt. The extension to be used for the Measurements table can be 
set by going to the main AIJ menu bar and selecting: Edit->Options->Input/Output and entering 
WKH�GHVLUHG�H[WHQVLRQ�LQ�WKH�³)LOH�H[WHQVLRQ�IRU�WDEOHV´�ER[� Note: it is preferable that an 
extension of .tbl be used for the Measurements table. 

It should be noted that if the differential photometry needs to be redone on images currently in 
the stack, the following steps should be done: 

1. Clear the existing aperture/aQQXOXV�ULQJV�E\�VHOHFWLQJ�WKH�³FOHDU�DSHUWXUHV�DQG�DQQRWDWLRQV�
IURP�RYHUOD\�³�LFRQ��  on the Image Display. 

2. On the Multi-Aperture Measurements Screen (Figure 13), make sure that the checkbox 
next to ³8VH�SUHYLRXV��;�DSHUWXUHV´�LV�XQFKHFNHG� 
 

7.5.3. Dealing with Misaligned Images 
 

A shift in image orientation and therefore misalignment could be the case if guiding is poor. If 
WKH�LPDJH�VKLIW�LV�QRW�WRR�VHYHUH��$,-¶V�$OLJQ�6WDFN�IXQFWLRQ�FRXOG�EH�XVHG�WR�DOLJQ�WKH�LPDJHV�LQ�
WKH�DFWLYH�VWDFN���7KLV�FDQ�EH�DFFRPSOLVKHG�E\�VHOHFWLQJ�WKH�³DOLJQ�VWDFN�XVLQJ�DSHUWXUHV´�LFRQ�
on the Image Display screen and entering a fairly large aperture setting, with correspondingly 
larger annulus settings. Images in the stack are aligned using this feature and the resulting 
DOLJQHG�LPDJHV�DUH�VWRUHG�LQ�D�QHZ�VXEGLUHFWRU\�ODEHOOHG�³DOLJQHG�´�,PDJHV�LQ�WKLV�VXEGLUHFWRU\�
should then be the ones used during the differential photometry phase. The user should not forget 
to change back the aperture and annulus settings to ones that are appropriate for the differential 
photometry phase. 

In the case of image rotation due to severe image shiIW��ZKLFK�$,-¶V�$OLJQ�IXQFWLRQ�FDQQRW�
correct, then the following can be done: 

1. First, plate solve each image (see Section 7.4). 
2. After plate solving has been completed, the user can then perform the differential 

photometry as before, except that on the Multi-Aperture Measurements screen (Figure 
13���WKH�ER[�ODEHOOHG�³8VH�5$�'HF�WR�ORFDWH�DSHUWXUH�SRVLWLRQV´�VKRXOG�Ee checked. In 
addition, the First and Last slice should indicate the entire range of slices. 

3. When the Place Apertures button is selected on this screen, the user would then place the 
aperture/annulus rings on the target and comp stars and, as before, press Enter on the 
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keyboard. All the images in the stack are now analyzed. 
 

7.5.4. Dealing with a Meridian Flip 
 

If a meridian flip had occurred during the imaging session, then the images would be rotated 
180° from the orientation shown in Figure 5.  Thus, for the images taken after the flip, the 
aperture/annulus rings would not fall on the correct locations for the target and comp stars. Note: 
even if the CCD camera itself was rotated immediately prior to the beginning of imaging after 
the meridian flip, it is unlikely that the target and comp stars would land within the same 
aperture/annulus rings. 

To conduct differential photometry with AIJ in the case of a meridian flip, the following method 
can be used (note: if there are misaligned images during the pre-flip period or during the post-flip 
period, then the method described in Section 7.5.3 should be used): 

1. First, plate solve just the first image in the entire sequence.  This is accomplished by 
HQWHULQJ�³�´�LQ�ERWK�WKH Start Slice and End Slice fields of the Astrometry Settings screen. 
This will cause just the first image in the stack to be plate solved. 

2. Next, the slice number for the image in the stack immediately following the meridian flip 
should be entered in these two fields and it should be plate solved. 

3. On the Multi-Aperture Measurements screen (see Figure 13)��WKH�FKHFNER[�ODEHOOHG�³8VH�
RA/Dec to locate apeUWXUH�SRVLWLRQV´�VKRXOG�WKHQ�EH�CHECKED and the checkbox 
ODEHOOHG�³+DOW�processing on WCS or centrRLG�HUURU´�VKRXOG�EH�81&+(&.('� 

When the differential photometry is now conducted, AIJ will proceed through the pre-flip 
images, using the coordinates in the first slice for placement of the aperture and annulus on 
subsequent pre-flip images, and then using the coordinates of the first slice after the flip for the 
remaining images in the stack. 
 

7.5.5. Storing and Later Retrieving Target and Comparison Star Locations 
 
It is sometimes desirable to store, and then at some later time retrieve, WKH�ORFDWLRQ�RI�WKH�XVHU¶s 
target and comparison star selections. AIJ provides this capability as follows. 

1. Before the differential photometry process begins, at least the first image in the stack 
should be plate solved. 

2. On the Multi-Aperture MeasXUHPHQWV�VFUHHQ��WKH�³5$�'HF�WR�ORFDWH�DSHUWXUH�SRVLWLRQV´�
entry should be selected, and  the ³8VH�SUHYLRXV�[�DSHUWXUHV«´� and ³+DOW�SURFHVVLQJ�RQ�
:&6�RU�FHQWURLG�HUURU´�entries should NOT be selected. 

3. Next, the user should place apertures on the target and the desired comparison stars and 
then press Enter to conduct the differential photometry on all the images. 

4. Once the Measurements table is created,  from the Image Display the user should then 
select File-!([SRUW�DSHUWXUHV�WR�5$�'HF�OLVW«�DQG�then store the resulting file of target 
and comparison star locations in the AIJ Analysis directory. 
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If the user then wishes to use this same selection of target and comparison stars at a later time, 
the following process would be followed: 

1. On the Multi-$SHUWXUH�0HDVXUHPHQWV�VFUHHQ��WKH�³8VH�SUHYLRXV�[�DSHUWXUHV«´�HQWU\�
VKRXOG�EH�VHOHFWHG��DV�ZHOO�DV�WKH�³5$�'HF�WR�ORFDWLRQ�DSHUWXUH�SRVLWLRQV´�HQWU\� 

2. On the Image Display, the user would then select File->Import apertures from RA/Dec 
OLVW« and choose the previously stored file of target and comparison star locations. The 
target and comparisons stars selections would then turn light green and red, respectively. 

3. Next, on the Multi-Aperture Measurements screen, the user would select the Place 
Apertures tab. 

4. The target and comparison star selections would then turn brighter green and red, 
respectively.  

5. The user would then hit Enter to begin the differential photometry process as usual. 
 

7.6. Prepare for Model Fit 
 

In preparation for a model fit, the Multi-Plot Main   icon on the AIJ toolbar should be 
selected. When this is done, the following four screens pop-up: 

Multi-plot Main 
Multi-plot Reference Star Settings 
Multi-plot Y-data 
Data Set 2 Fit Settings. 

An AIJ file with an extension of .plotcfg contains the information used to create these screens. A 
template.plotcfg file that the user can start with can be found at http://astrodennis.com.   The user 
can open a .plotcfg file by going to the upper left corner of the Multi-plot Main screen and 
VHOHFWLQJ�³)LOH-!2SHQ�SORW�FRQILJXUDWLRQ�IURP�ILOH«´��/LNHZLVH��WKH�FXUUHQW�LQVWDQFH�RI�WKH�
DERYH�VFUHHQV�FDQ�EH�VWRUHG�E\�VHOHFWLQJ�³)LOH-!6DYH�SORW�FRQILJXUDWLRQ«´ 

The first step is to update correct values in the AIRMASS, HJD_UTC, and BJD_TDB column 
entries in the Measurements table if this was not done during the Calibration phase (see Section 
7.2 above). This is accomplished as follows: 

From the Multi-SORW�0DLQ�PHQX��VHOHFW�³7DEOH-!$GG�QHZ�DVWURQRPLFDO�GDWD�FROXPQV�WR�WDEOH�´�
7KH�IROORZLQJ�WZR�VFUHHQV�WKHQ�DSSHDU��³03�&RRUGLQDWH�&RQYHUWHU´�DQG�³$GG�DVWURQRPLFDO�GDWD�
WR�WDEOH´��VHH�Figure 15). 
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Figure 15.  Screens for Correcting AIRMASS and Time Standard Values 

On the MP Coordinate Converter screen, verify that the values are correct for Geographic 
Location of Observatory and the J2000 Equatorial Coordinates for the target star. Also, select 
Auto under the Dynamical Time section.  2Q�WKH�³$GG�DVWURQRPLFDO�GDWD�WR�WDEOH´�VFUHen, verify 
that the boxes are checked as shown in the right-most screen in Figure 15, and then select Update 
7DEOH��3UHVV�2.�LI�WKH�³2YHU-ZULWH�H[LVWLQJ�GDWD"´�dialog box appears.  The AIRMASS, 
HJD_UTC, and BJD_TDB columns in the Measurements table will then be updated. 
 

7.7. Conduct Model Fit 
 

On the Multi-plot Main screen, the default X-data (namely the timeframe to be used) should be 
selected. In the example shown in Figure 16, because values for the (preferred) timeframe of 
BJD_TDB have been included in the Measurements table, BJD_TDB is selected. Appropriate 
entries for Title and Subtitle are also made.  

Also on the Multi-plot Main screen, under the Fit and Normalize Region Selection box, entries 
are made for the Left and Right boxes that represent the predicted transit start and end times, 

respectively. At the upper right of the Multi-plot Main screen, the copy icon  is then 
selected. This positions the Predicted Ingress and Predicted Egress times on the V.markers at the 
appropriate places on the Plot of Measurements screen. The V.markers should remain untouched 
thereafter in order to show what the initial predictions were.  However, the Fit and Normalize 
markers should later be positioned to the apparent ingress and egress points as shown on the Plot 
of Measurements screen (Figure 22). The Fit and Normalize markers are used by AIJ to define 
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the out-of-transit data that is used to compute a baseline that the model fit uses to compute the 
relative normalized flux across the entire observation.  

The Left Trim and Right Trim fields can be used to eliminate some amount of pre-ingress and 
post-egress data from the model. This might be done, for example, if there were systematics 
during the beginning or end of the observing session.  The values in the Meridian Flip, Fit and 
Normalize Region, and V.Marker boxes are only the decimal part of the associated time (for 
example, 0.83508 would be entered if the time in question was 2457395.83508). If, however, the 
begin time is, say, 2457395�������DQG�WKH�HQG�WLPH�³UROOV�RYHU´�LQWR��VD\�����������������WKHQ�
the begin decimal part should be 0.83508, but the end decimal part should be 1.00175. 

Next, under the X-Axis Scaling box, check the Auto X-range button and click on the  icon. 
The X-min and X-max boxes will automatically be filled in with the minimum and maximum X 
values (BJD_TDB times in this example) that are in the Measurements table.  Note: for this to 
work, at least one row on the Multi-plot Y screen (see Figure 17) should have its checkbox 
checked in the Plot column. Alternatively, the user can click on the Custom X-range box and fill 
in different X-min and X-max values. The Y-Axis Scaling box can be used now or later to allow 
the various plots to be sized so they all appear on the Plot of Measurements screen (see Figure 
22). The PORW�6L]H�HQWULHV�DUH�XVHG�WR�VL]H�WKH�3ORW�RI�0HDVXUHPHQWV�VFUHHQ�RQ�WKH�XVHU¶V�
computer monitor. 

 

Figure 16.  Multi-plot Main Screen 
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If a meridian flip has occurred, or if there is a break in the image session and the stars have 
moved to a different part of the CCD detector, then the Meridian Flip box on the Multi-plot Main 
screen is used to place a line in the middle of the gap where this discontinuity of data has 
occurred. The Show box should be checked and an entry made in the Flip Time box so that the 
Meridian Flip line is placed on the Plot of Measurements screen at the appropriate place. 
 

7.8. Light Curve Plot 
 
Before a visual plot of selected data sets can be obtained via the Plot of Measurements screen 
(Figure 22), the Multi-plot Y Data screen (Figure 17) needs to be setup.  This is the main screen 
that determines where and how different data sets are plotted 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 17.  Multi-plot Y Data Screen 

The following are the key parameters and selections for the Multi-plot Y screen: 
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The Plot column is used to select if a particular data set is to be plotted. 

For each particular data set, the X-data column indicates what values from the 
Measurements table are used on the X-D[LV��$�VHOHFWLRQ�RI�³GHIDXOW´�HTXDWHV�WR�WKH�
default values specified on the Multi-plot Main screen; in the example used throughout 
here, BJD_TDB is the default. The Y-data column is used to select which columns in the 
Measurements table are used for the Y-axis values. 

The Bin Size column indicates the number of points in the associated data set that are 
combined (binned) into one point. Note that ³ELQQLQJ´�KHUH is different from the concept 
of binning used when, for example, CCD photosites are binned together. Note that 
binning is for display purposes only and does not change the underlying Measurements 
table data, unless the user adds additional columns containing binned data as described in 
Section 7.12. 

The Fit Mode column is used to select the type of fit that should be applied to the 
respective data set, as well as the span of data (indicated by the green area) that will be 
included in the fit. Thus, as seen in Figure 22, the raw data points of the relative change 
in flux of T1 are plotted with no fit, while the second plot is a fit of this same data using 
an assumed transit model.  Also as seen in this example, the relative flux changes of three 
comp stars are fit with a straight-line model (as will be seen later, one of the original 
comp stars, C5, was deselected after it was found to have significant residual errors).  The 
reason for the latter three plots being linear is because it is assumed that there should be 
no relative changes in the comp star brightness throughout the imaging session, unlike the 
relative flux of T1 where it is assumed that it will reflect a dip in brightness due to the 
H[RSODQHW¶V�WUDQVit. 

The Trend Select column serves two purposes. First, it reflects the detrend parameters 
that are being applied to the associated Fit Mode, which themselves will be selected on 
the Data Set 2 Fit Settings Screen (Figure 18).  Active detrend parameters are indicated 
by green. Second, selecting a particular detrend parameter will reflect its Trend 
Coefficient and the associated type of detrend data (e.g., AIRMASS). 

The Norm/Mag Ref column indicates the range of data used to normalize the respective 
data set. In the example in Figure 17, the relative flux of T1 is normalized based on the 
out-of-transit data ± i.e., data to the left of the begin-of-transit (ingress point) and to the 
right of the end-of-transit (egress point). As discussed earlier, these latter two points are 
set by the values in the Fit and Normalized Region Selection boxes on the Multi-plot 
Main Screen (Figure 16). 

When checked, the Page Rel column indicates that the Scale and Shift columns should be 
interpreted as the percentage of the Y-range.  Unchecked means that the Scale and Shift 
values are absolute numbers applied to the Y-range. The Scale and Shift values, along 
with the Y-min and Y-max values on the Multi-plot Main screen, are used to properly 
position the various plots on the Plots of Measurements screen. It should be noted that the 
raw data set representing the relative flux of T1 (namely the first row in Figure 17) 
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should always have a Scale value = 1. This is because this data may be used by other 
global fit programs and should not be scaled. 
 

7.9. Data Set Fittings Screen 
 

The Data Set 2 Fit Settings Screen (Figure 18) is automatically opened whenever there is a 
Transit Fit selected for a data set (in this case Data Set 2) under Fit Mode on the Multi-plot Y 
Data screen (Figure 17). The following user inputs on the Data Set 2 Fittings Set Screen are 
made that affect the resulting light curve: 

Period ± the orbital period, if it is available, from http://exoplanets.org/; for example, in 
the case of WASP-12b, it is 1.09142245 days. 

Host Star Parameters ±  the spectral type (Sp.T) of the host star; this is strictly to estimate 
the radius R* of the host star, which itself is used simply to calculate the radius of the 
exoplanet. If the user has knowledge of R* (for example, from http://exoplanets.org/ ) 
then this value may be entered in the R*(Rsun) box. In this example for WASP-12, 
R*=1.630. 

Quad LD U1 and Quad LD U2 ± these are the quadratic limb darkening coefficients 
associated with the host star and the particular filter being used. These values can be 
found by using the limb darkening coefficient calculator at 
http://astroutils.astronomy.ohio-state.edu/exofast/limbdark.shtml.  In the example here, 
the coefficients used for WASP-12b are 0.39056081 and 0.3026992, respectively. Note 
that these are placed in the Prior Center Column and locked. 

The AIRMASS Prior Center value should be set to 0.0 in most cases. 
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Figure 18.  Data Set 2 Fit Settings Screen 

The Y-min and Y-max values on the Multi-plot Main screen can be adjusted to display desired 
portions of the Measurements table on the plot, although as previously mentioned, it is best to 
select Auto-X-range under X-Axis Scaling on the Multi-plot Main screen to display the entire 
range of X-values. 

It is possible to see how the fit is improved by applying any number of Detrend Parameters. The 
most common is AIRMASS. Other Detrend Parameters can also be selected. If a meridian flip or 
a break in data collection has occurred where stars have moved on the CCD detector, then 
Meridian_Flip can also be selected (note that if this is done, the Flip Time selection and value 
must be made on the Multi-plot Main screen). Other Detrend Parameters could also be selected 
to see their effect(s) on the model fit. A good rule of thumb for whether a Detrend Parameter is 
effective is to view the Bayesian Information Criterion (BIC) value. If it reduces by more than 
3.0 when a Detrend Parameter is selected, then that Detrend Parameter should be selected. If it 
decreases by less than 3.0 or increases, then the Detrend Parameter is not that relevant. See 
Section 7.11 for a more detailed discussion on selecting detrend parameters. 

Plot Settings on the Data Set 2 Fit Setting Screen are used to define if and how the transit model 
and residuals are displayed. In addition, a Shift value is used to move the residual plot up or 
down on the Plot of Measurements screen. 

Finally, the Multi-plot Reference Star Settings screen (Figure 19) is used to deselect or select 
which comp stars the user would like to include in the model fit.  This is useful if it is determined 
DIWHU�YLHZLQJ�D�SDUWLFXODU�FRPS�VWDU¶V�UHODWLYH�IOX[�LQ�WKe Plot of Measurements screen (Figure 
22) that its data points do not follow a linear fit ± i.e., an indication that it is most likely a 
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variable star. In the example here, it was determined that comp star C5 had a large number of 
residual errors. Thus, it was deselected from the ensemble of comp stars to be used (see Figure 
20). WKHQ�WKLV�GHVHOHFWLRQ�WRRN�SODFH��FRPS�VWDU�&�¶V�LGHQWLILHU�ZDV�FKDQJHG�WR�7��ERWK�RQ�WKe 
screen depicted in Figure 20, as well as on the Image Display (see Figure 21). Its Plot selection 
box in Figure 17 was then unchecked so its plot no longer appeared in Figure 22. 
 

 

Figure 19.  Multi-plot Reference Star Settings Screen 

 

 

Figure 20.  Multi-plot Reference Star Settings Screen after C5 was Deselected 
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Figure 21.  Updated Images Display Showing C5 Changed to T5 

1RWH�WKDW�&�¶V�GDWD�LV�QRZ�QRW�LQFOXGHG�LQ�WKH�model fit, but its data is still maintained in the 
Measurements table. 

The settings in Figure 16, Figure 17, Figure 18, and Figure 20 produced the light curve and other 
plots shown in Figure 22.  

Figure 23 is an example of an exoplanet fit based on data collected by amateur astronomer Paul 
Benni for exoplanet Wasp-76b. It shows how a Meridian_Flip detrend parameter was used to 
take care of an offset in data points caused by the target and comp stars landing on a different 
part of the CCD detector after the meridian flip occurred. 
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Figure 22.  Plot of Measurements Screen 
 


